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TERMS AND CONDITIONS

The following terms and conditions constitute the agreement between Elsevier Science B.V. ("Elsevier") and the
individual ("the User") authorised by Elsevier to have access to, SMART.

LICENSE
Elsevier hereby grants the User a non-exclusive, non-transferable personal license to access and use SMART for
individual submission of research papers to Brain Research and Sections (Brain Research Reviews, Molecular Brain
Research, Developmental Brain Research, Cognitive Brain Research and Brain Research Protocols). The User is
permitted to: (i) download SMART to electronic memory for subsequent single access and use by the User; and (ii)
submit research papers to Brain Research or its Sections using SMART.

The User may use SMART only in accordance with the terms and conditions of this agreement. The User must not
permit others to: (i) reproduce, transmit, disseminate or otherwise make available SMART or any part of it to any
third party whether in return for a fee or otherwise by any means (whether electronic or otherwise); (ii) delete or
obscure Elsevier's copyright notices (including notices as to any other intellectual property rights) from SMART.

COPYRIGHT
No rights of ownership, copyright or any other intellectual property rights relating to SMART (including but not
limited to its structure and lay-out) or to any other material contained in it are transferred to the User by this
agreement. Whenever any part of SMART is printed out by the User, the first sheet printed out will contain
Elsevier's copyright notices.

Subscription fees and any other sums specified in or relating to this agreement are exclusive of value added tax (or
any successor tax or equivalent local tax), which will be added and shall be payable in accordance with the law
applicable from time to time against receipt of an appropriate invoice.

WARRANTIES AND INDEMNITY

WARRANTY LIMITATIONS: (i) SMART is provided on an "AS IS" basis, without warranties of any kind, either
express of implied, including, but not limited to warranties of title, or implied warranties of merchantability of
fitness for a particular purpose; (ii) use of SMART is at your own risk; (iii) access to SMART may be interrupted
and may not be error free; and (iv) neither SMART nor Elsevier, involved in creating, producing or delivering
SMART, ot the materials contained therein, shall be liable for any direct, indirect, incidental, special, consequential
or punitive damages arising out of the use of, or the inability to use SMART.

The User shall indemnify Elsevier against any costs, damages, claims, expenses (including reasonable legal fees) or
other liabilities incurred by Elsevier in connection with any claim made against Elsevier by any third party arising
from negligence of or any breach of this agreement by the User. Elsevier reserves the right, at its discretion, to issue
an amended or modified version of SMART, or to require the deletion of any part of  SMART, which might in
Elsevier's opinion be the subject of a claim by any third party.

GENERAL
This agreement represents the entire agreement between the parties in relation to its subject matter and supersedes
all previous agreements, whether written or oral. No delay in exercising or non-exercise by either party of any of its
rights under or in connection with this agreement shall operate as a waiver or release of these rights.

If any part of any provision of this agreement is invalid or unenforceable, then the remainder of such provision and
all other provisions of this agreement shall remain valid and enforceable.  This agreement shall be governed by and
construed in accordance with the laws of the Netherlands. Any dispute arising in connection with this agreement, or
the breach thereof, shall, in the absence of an amicable solution by the parties, belong to the exclusive jurisdiction of
the competent courts in Amsterdam, the Netherlands.
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i Welcome to Synapse

Welcome to SMART

SMART (System for Manuscript Authoring and Review Technology) is a

collection of programs supporting the submission of peer-reviewed science

manuscripts through the review cycle.  SMART uses the Internet as the

connecting network among all users.  The basic submit/review/edit cycle

is not affected.  Manuscripts are still written in the same manner as before

and review is still done on a peer review basis.  However, manuscripts are

electronically  sent to both journal Editors and Reviewers, reducing the

time-to-review, time-to-publish, and time-to-read periods.

SMART has four basic software applications.

Submitter - Authors use this to assemble manuscripts and to transmit

them to the SMART server over the Internet.  Submitter also checks the

status of the review cycle.

Reviewer - Reviewers use this to retrieve manuscripts from the SMART

server and, to enter comments, evaluations, and scores, and to transmit

them back to the SMART server.

Editor - Editors and staff members of the journals use this to log into the

server and to retrieve new manuscript submissions, assign Reviewers, send

notifications to Reviewers, see Reviewers' evaluations, and to take final

actions of manuscripts.

Server - this interacts with all other SMART applications to receive, send,

hold, and analyze all information flow (manuscripts, data, EMail).
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For this first version, SMART sends the actual disk file of the manuscript

written with any certified word processing program.  The Editor  retrieves

the file and translates it into the word processor format used by the Reviewer.

Some parts of the manuscript may be entered directly into the manuscript

description using SMART.  This is presently optional.  SMART later will

be an authoring tool, where the Author creates his entire manuscript with

SMART and transmits this information to the SMART server.
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Before You Begin

This chapter deals with topics that you should be aware of before using

SMART for the first time.

• Package Contents

• Hardware and Software Requirements

• Installing the Software

• About this Manual

• How to use this Manual

• Technical Support
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Package Contents

If you received the SMART software package directly, it contains the

following:

• This manual

• Installation disks

• One SMART registration card

If you received SMART from the Internet electronically, you have one

installation file.  Refer to the section on Installing the Software to

continue.
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Hardware and Software Requirements

Macintosh

• A Macintosh IIfx or later, with a hard drive and 10 MB free for

complete installation.  A 68030 minimum processor is

recommended

• System 7.1 or later

• 5 MB minimum available RAM

Power Macintosh

• Hard drive and 15 MBytes free for complete installation

• System 7.1 or later

• 15 MB of available RAM
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Installing the Software

Installations disks - if you have installations disks, follow these instructions

to install SMART:

1.Turn on your Macintosh if it is not already on

2. Quit any applications that are active

3. Insert Installer Disk 1 into any floppy drive

4. Double-click Install Me to begin the installation process

5. Follow the prompts on your screen

6. Eject the Installer Disk 1 and store all disks in a safe place

Network download - If you have an installation file from the Internet,

follow these instructions to install SMART:

1. Turn on your Macintosh if it is not already on

2. Quit any applications that are active

3. Double-click Install Me to begin the installation process

4. Follow the prompts on your screen

The installation process creates a SMART folder containing all of the

folders and files of SMART, including the Submitter application and creates

a Preferences folder in the System Folder: Preferences:SMART folder.

Several files are copied to the Extensions folder:

AOS PowerPlug

AOS Runtime

GNU RegEx (fat)
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WASTE (fat)

Several files are also copied to the Extensions folder depending on the

Macintosh model:

ANSI C CFM68K Lib....................................................(For 68K machines)

ANSI C PPC Lib........................................................... (For PPC machines)

To Register Your Copy of the Software

Registering your copy of SMART is important.  By registering, you get

free Technical Support (see the section on Technical Support) and you

will be notified of all improvements and upgrades  to the software.
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About this Manual

This manual provides both instructional and reference material to help you

get the most from using SMART.  The manual consists of:

• QuickStart

• The Basics

• The SMART Document

• Entering Authors

• Creating a Manuscript

• Appendixes

QuickStart should be read if you installed the software, are familiar with

Macintosh applications, and want to begin using the application immediately

The Basics contains information on initial files created, user interface

issues, and network communications

The SMART Document introduces you to the use of the document, what

it contains, and how to maintain it

Entering Authors discusses how to create and maintain Author data for

manuscripts

Creating a Manuscript discusses how to create and maintain manuscript

information, how to add Authors to the manuscripts, and how to submit

the manuscripts to the server

Appendices has all of the appendices mentioned in the other sections,

such as certified word processors, optimizing memory, networking issues,

commercial and software utilities that make using SMART software perform
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better, and an expanded list of themes.

Conventions used in this manual

Whenever special attention is required for a topic, the Alert graphic is

displayed.

Whenever there is a good tip useful to remember, the Tip graphic is

displayed.

Whenever there is emphasis required on a certain point, the By The Way

graphic is displayed.
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How to use this Manual

This manual assumes that you are familiar with basic Macintosh operations,

such as pressing and dragging the mouse; selecting, copying, and moving

icons of files and folders; choosing commands from pull-down and pop-up

menus; pressing on buttons to activate commands, opening and closing

documents, launching applications, managing windows and their scrollbars,

title bars, close box, and zoom box; and using the Finder.  If you are not

familiar with these terms and operations, read your Macintosh User’s

Guide to learn more about your Macintosh.
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Technical Support

We have worked hard to make sure that the software and the manual are

easy to use.  Should you have any difficulty, please follow the instructions

below.

We support SMART users via EMail.  If you are having difficulties and

cannot find the answers in these manuals, please EMail us a note.

Before Calling for Help

1. Make sure that your computer is properly set up, and that all

cable connections are secure.

2. Make sure that you have properly installed the software according

to the installation instructions in these manuals.  All software

extensions installed have no known conflicts with other extensions.

3. Be sure that you have sufficient memory (RAM), especially if

you are running on a PowerMac.

4. Be sure that you are correctly configured to access the Internet

via TCP/IP.  Contact your Network Administrator if you suspect

a problem.

5. If you suspect a hardware problems or a problem with your

system software, contact your local Apple deal
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EMailing for Help

SMART support is currently limited to EMail.  You will receive a prompt

answer via EMail.  Please include your Macintosh model name and number,

the version of SMART, and a brief description of the problem.

EMail to:

SMART@scripps.edu

Please put the word Tech Support in the subject heading.
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Chapter 1
Quickstart

Read this chapter if you are familiar with Macintosh applications and want

to use SMART right away.  This section assumes that you have already

installed SMART.

1. Double-click Submitter to launch the application.  A new

document window opens.

2. Select Configure... from the File Menu to enter in the SMART

server IP address.

3. Create all the Authors for the manuscript by selecting New

Author from the Authors Menu .  Enter in information on each

Author.  Press on the Save button to save this information into

the docment.

4. Press on the New button in the document window to open a new

manuscript window.  Add Authors by dragging the red triangle

in the Author window to the manuscript window’s list of Authors.

5. Drag one of the Authors to the field labelled Corresponding

Author.

6. Enter other required parts of the manuscript - title, format,

journal, theme, keyword, cover letter, and files.

7. Enter other optional parts of the manuscript - abstract, body,

legends, references, suggested Reviewers, and comments.
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8. Press on Submit to being the submission process.

The document window indicates the date and time of submission of all

manuscripts.  Use the Check button in the document window to check on

the status of the manuscript during the review process.  When the manuscript

goes beyond the review process, the Editor of the journal notifies you via

EMail, postal mail, or telephone.
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Chapter 2
The Basics

This chapter contains information on initial files created, user interface

issues, and network communications.

• Launching for the First Time

• User Interface

• Configuration
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Launching for the First Time

Double-click on Submitter to launch the application.  When Submitter

launches for the first time, a folder named SMART is created in your

Preferences folder (Figure 2.1).  In this folder is an additional folder

named for the Port number assigned to the SMART client.  This number

is generally 7000.  Finally, inside this folder is and additional folder named

Client Patches and a file named Client Preferences.   Client Patches

holds software patches supplied in the future.  Client Preferences contains

the data on user preferences.

Figure 2.1
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User Interface

The user interface experience is similar to other Macintosh programs.

Windows are used to convey most of the information to and from SMART.

There is a single window, called the document window containing all of

the manuscripts that you submit to SMART.

Some fields in windows may be multi-columned (Figure 2.2).  The width

of the columns can be adjusted by positioning the cursor on a vertical line

of a column.  The cursor changes to a column cursor.   While pressing the

mouse button down, drag the mouse from left to right to resize the column.

Any columns to the right of the vertical line being adjusted shifts left and

right by the same amount.  To adjust only the immediately adjacent columns

of the vertical line, hold down the Control key when moving the mouse.

Column Cursor

Columns

Column Titles

Figure 2.2

Column Cursor
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Tip: Hold down the Control key when adjusting the column to adjust

only the current columns touching the vertical line.

Many windows are also sensitive to drag and drop.  If you select certain

data or lines of text, and then drag this to another window, or to the

Macintosh Finder desktop, data are copied, transferred, or exported.

Likewise, some windows may have files dragged into them.  See later

chapters for more specific information on the capabilities of each window.

Alert: Drag and Drop must be supported in those applications.

Figure 2.3 shows the text of the title being dragged from the manuscript

window to the desktop, creating a text clipping file.
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Drag and drop with mouse

Figure 2.3

Many of the fields of windows also accept fully styled text.  To change the

text directly in a field, select Text Tool from the Edit Menu  to open the

Text Tool Window (Figure 2.4)

Figure 2.4

To change text:

1. Select the text to be changed using the mouse

2. Press on the various controls in the Text Tool Window to

alter the font, the style, the size, or the color
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Configuration

SMART must be configured with the server IP address.  Select Configure...

in the File menu  to enter in the address.  A window opens asking for the

IP address of the server (Figure 2.5).

Figure 2.5

Using the keyboard, type in the address assigned to the server and then

press Accept.  This can be in the form of a dot IP address notation as

shown in Figure 2.5 or as the physical name of the machine as shown in

Figure 2.6.  Press Cancel to close the window without storing the address.

Figure 2.6

The last used IP address is displayed as the default address.  If SMART

was just installed, a pre-configured address is displayed.  If the address is

correct, simply press Accept.
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Alert: See the separate note for the current IP address and name of the

SMART server that you should use for configuration.

You only need to configure this information once.  Reconfiguration is

required if one of the following conditions occur:

• The preference file is deleted or becomes corrupted

• The address of the server changes

• You reinstall a new version of the operating system that may

create a new system Preference folder
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Chapter 3
The SMART Document

This chapter will show you how to use SMART to create manuscript

objects and store them in SMART documents.

• Creating a New Document

• Opening an Existing Document

• Saving a Document

• Password Protecting a Document

By The Way: The term OBJECT is used repeatedly throughout this manual

and refers primarily to a database record.  The database itself consists of

two primary tables - manuscripts and people.  Therefore, the two primary

kinds of objects are manuscript objects and people objects.

A manuscript object is a group of data describing a manuscript prior to

submission.  You enter information using various windows and functions

and attach disk files containing the actual content of the manuscript.  Other

word processing or graphics programs were used to prepare these files.

A SMART document is file-based and contains the manuscript objects.

Normally, a Corresponding Author stores related manuscripts in one
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document.  One document may contain any number of manuscripts  to be

submitted or currently submitted to any number of journals.  Documents

may be protected with passwords and are portable to other computers

running SMART.

A document window is a Macintosh window displaying all of the

manuscripts in the SMART document .
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Creating a New Document

A document needs to be opened before working with any objects.  A new

document automatically opens when starting SMART.  Thereafter, other

new documents can be opened manually.  Multiple documents can also be

opened simultaneously.

Select New Document in the File Menu  to create a new document.  The

keyboard equivalent of Command-N can also be entered from the keyboard

This menu item is always enabled.  A new Document Wndow named

Untitled opens (Figure 3.1).

List of manuscripts

Function Buttons

Progress Bar

Message Field

Figure 3.1
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By The Way: Only the New button is normally enabled, since there are

currently no selected manuscripts.  All other buttons were enabled for

illustration purposes only.

This is an empty document window.  No manuscripts have been created

nor submitted to SMART.  Most of the functions maintaining the manuscript

objects are controlled from the Function Buttons near the top.

• New - creates a new manuscript object and opens it in a new

manuscript window named New Manuscript.  This button is

always enabled.

• Open - opens an existing manuscript object into a manuscript

window whose title is the same as the title of the manuscript.

This button is always enabled.

• Delete - deletes an existing manuscript object from the document.

A manuscript object cannot be deleted once that manuscript is

submitted.  This button is enabled only when a manuscript is

selected.

• Check - checks a submitted manuscript object.  The SMART

server returns a message.  This button is enabled only when a

manuscript is selected and submitted.  The extent of the message,

if any, is determined by the editors.
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• Print - prints an existing existing manuscript object.  Only

information related to the manuscript and not its contents is printed.

This button is enabled only when a manuscript is selected.

Only one manuscript may be selected in the List of Manuscripts

(Figure 3.2).  To select a manuscript, press once anywhere on the line in

the list.  Columns display specific information about each manuscript.

Figure 3.2

• ID - this is a unique identification number assigned to the manuscript

once the manuscript is submitted.  This field is empty when the

manuscript has not been submitted.  This ID is used for all

communications regarding the manuscript.

• Title - this is the title of this manuscript.  The title also appears in

the titlebars of the opened  manuscript windows.

• Authors - these are all of the Authors, listed from first Author to

last Author.  If no Authors are entered, No Authors is displayed.

• Journal - this is the journal of the manuscript.  If no journal is

entered, None Recorded is displayed.

• Status - this is the status summary of the manuscript.  If the
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manuscript has not been submitted, Not Submitted  is displayed.

Otherwise, time and date information of submission is displayed.

The Progress Bar moves when communicating with the server, or when

some important function occurs.  The Message Field displays information

relevant to the progress.
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Opening an Existing Document

Documents saved to disk files can be reopened.  Select Open Document...

in the File Menu to open an existing document on a mounted disk volume.

The keyboard equivalent of Command-O can also be entered from the

keyboard.  This menu item is always enabled.  A file dialog opens (Figure 3.3)

to select the file document.

Figure 3.3

Only SMART file documents are displayed.  When Open is pressed, a

document window named John Doe opens (Figure 3.4)

One Manuscript

Figure 3.4



18 Chapter 3

This window reflects the file document.  John Doe is most likely the

Corresponding Author for these manuscripts.  This illustration shows one

manuscript that has not yet been submitted to Brain Research .  The title

of the manuscript is The Cytoarchitectonics of the Nucleus Ambiguus in

theRat.
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Saving a Document

An modified document which has not yet been saved to disk, either opened

from a file or new, displays with a bullet character • before the title of the

window (Figure 3.5).

. Saved Document

Unsaved Document

Figure 3.5

Select Save Document in the File Menu to save an opened document to

the disk volume.  The keyboard equivalent of Command-S can also be

entered from the keyboard.  This menu item is enabled only when the

document window is the active window, and if the document  is modified.

If the window is closed and the document has been modified, an alert

opens asking to save the document.  If the document is opened from an

existing file, the document is saved to that file, and the bullet • character is

removed from the window titlebar.  If the document is new, a file dialog

opens (Figure 3.6) for the name of the document and location of storage.

Figure 3.6
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The default name is Untitled.  Press Save to save the document to disk, or

press Cancel to abort the operation and not save the document.
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Password Protecting a Document

Any document may be protected with a password.  The password is requested

twice when opening a document.  To assign a password to a document,

select Password... in the File Menu.  This menu item is enabled only

when a document window is the active window.  A window opens asking

you to enter in the password twice (Figure 3.7).

Enter the password in this 
window for the first time

Second field appears in which you 
type the same password again

Click  on Accept to 
install the password

Figure 3.7

Press Accept to accept the passwords.  A message window opens indicating

that the password has been changed Figure 3.8 .  The password is permanently

stored when the document is next saved.
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Figure 3.8

Opening a protected document asks for the password (Figure 3.9).

Figure 3.9

Alert: The password is CASE SENSITIVE .  If you forget the password,

you cannot gain access to the contents of the document.  Contact Technical

Support if that happens.
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Chapter 4
Entering Authors

This chapter will show you how to enter in Authors as objects into the

SMART document.  The Authors are then used to create manuscript objects.

• Creating a New Author

• Listing All Authors

• Updating an Author
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Creating a New Author

An Author object is created for each Author of a manuscript.  Within one

SMART document, identical Authors of multiple manuscripts may be shared

from one Author object.  Each Author is viewed in an Author Wndow.

To create a new Author object, select New Author... from the Authors

Menu to open a new Author Window (Figure 4.1).  This menu item is

enabled only if a document window is opened.

Display Popup Button

Personal Info Area

Contact Preference

Figure 4.1

The window initially displays the personal information, as indicated by the

display popup button initially labelled Personal Info .  Each of the fields

are write enabled so data can be entered.  The Insert cursor is positioned

in the first field labelled Last Name.  Press the TAB key to move forward

to the next field, or SHIFT-TAB to move back one field.

Fill in each field as completely as possible.  Only the last name and the

first name are required in order for the information to be saved to the
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document.  When these two fields are completed, the Store button is

enabled.

The Contact Preference button is a popup menu with three options for

contact.  These options are similar to the notification options for the

Corresponding Author.  The contact preference information determines

the preferred mode of contacting this Author.

Pressing the popup button labelled Unknown pops up a list of degrees

(Figure 4.2).  Select the correct degree from the menu and the name of the

popup button changes to this selection.

Degrees

Figure 4.2

• Pressing on Cancel closes the window without saving any information.

• Pressing on Save or selecting Save this author to document of the

Authors Menu saves the information to the document.  The title of

the window changes to the name of the Author.  The Save button

and the menu item are enabled only when both the last name and
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the first name are entered.  This window is not closed when the

Save button is pressed.

Pressing on the display popup button labelled Personal Info button lists

more display options.  Selecting Profile from the popup menu (Figure 4.3).

displays more fields that pertain to the profile of the Author.

Select this if this 
person has Internet 

access

These fields are unlimited 
styled text fields

Figure 4.3

Information on the profile of this person is entered in these fields  These

fields may hold an unlimited amount of text.  As with the other fields, full

styles, fonts, sizes, and colors are supported.  Use the Text Tool Window to

assist in creating style changes.

Selecting Internet Access indiates that this person has access to the Internet.

This information helps determine how to contact this person.

Pressing the Save button  saves the Author to the document.  Closing the

window requests a save if the Author object is new or modified.
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Listing All Authors

All the Authors entered for a document can be listed by selecting List All

Authors... from the Authors Menu (Figure 4.4).

Adjustable Columns

Authors listed here

Press here to open selected authors

Figure 4.4

Selecting one or more of the Authors in the list enables the Open button.

Pressing on Open or double-clicking on the selected items opens up the

individual author window on each Author.
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Updating an Author

When an author window opens on an existing Author, the button labelled

Open is now labelled Update (Figure 4.5).  Pressing on this button updates

the information in the document with the information of the author window.

Closing the window requests an update if the Author object is modified.

Labelled Update when
a window is opened
on an existing author

Figure 4.5

Update this person to document of the Authors Men can also be selected.

Both the Update button and the menu item are enabled when the Author

object is modified.

Notice the appearance of a RED TRIANGLE (Figure 4.6).  This is a link

control button that associates this Author with the list of authos in a

manuscript.  The use of this button is described in the next chapter.
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Link Button

Figure 4.6
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Chapter 5
Creating a Manuscript

This chapter will show you how to use a manuscript object to hold all of

the manuscripts and their information for submission to SMART.

• Creating a New Manuscript

• Adding Authors

• Deleting an Author

• Author Order

• Corresponding Author

• Determining Completeness

• Finishing up the Manuscript

• Opening a Manuscript

• Deleting a Manuscript

• Printing a Manuscript

• Submitting the Manuscript

• Checking a Manuscript
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Creating a New Manuscript

Before submitting a new manuscript to SMART, the manuscript is authored

using a word processor certified for use.  A list of word processors appears

in Appendix A.  Any number of disk files may be used.  After the manuscript

files are created, the files are attached to a manuscript object  with more

detailed information,  This entire manuscript object is then sent over the

Internet to the SMART server.  Each manuscript object is viewed in a

Manuscript Window.

Press on the New Button in the document window or select New Manuscript

in the Manuscripts Menu to create a new manuscript object.  A new

manuscript window opens for this manuscript (Figure 5.1).  This menu

item is enabled only if a document window is opened.

Enter title here

Select Notification Method 
of Corresponding Author

Select Format of this manuscript

Select Journal for this manuscript

Select Theme for this manuscript

Window control buttons

These buttons will display more 
information on the window

Figure 5.1

Window Control Buttons - The buttons at the bottom control the window.
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• Cancel closes the window without saving the changes.

• Submit sends the manuscript to the server when the manuscript

is complete and ready to send.  This button is enabled only when

the manuscript is complete.

General Manuscript Information - The following information should be

entered.

• Title - The title field is a fully styled text field, accepting any

fonts, size, style, or color.  The field is also sensitive to drag and

drop from another Macintosh window (Figure 5.2).

Figure 5.2

• Journal - The journal for this manuscript is selected from this

popup menu (Figure 5.3).  Brain Research Interactive is the only

default selected for now.
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Select the journal for 
this manuscript from 

this popup menu

Figure 5.3

The selected journal name appears in the Journal Field (Figure 5.4).

Figure 5.4

By The Way: SMART can handle submissions to multiple journals for

multiple manuscripts in one document.  You do not need to make a separate

document for each journal.

• Theme - The theme for this manuscript is selected from this

popup menu (Figure 5.5).  The menu is hierarchical, showing the
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major themes in the primary popup menu, and the minor themes

in the secondary menus.  See the Appendix on Themes for a

complete listing.

Select the theme for this 
manuscript from this 
popup menu.  This is a 
hierarchical menu.  The 
first menu shows the 
Themes, and the second 
menu shows the topics

Figure 5.5

The selected theme appears in the Theme Field (Figure 5.6).

Figure 5.6

• Notification - The method of notifying the Corresponding Author

for this manuscript is selected from this popup menu  (Figure 5.7).
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Select the 
Notification 

method from this 
popup menu

Figure 5.7

The current choices are:

1. EMail - the EMail address of the Corresponding Author must

be entered in the Author object (see chapter Entering Authors

to learn how to enter in the EMail address)

2. FAX - the FAX number of the Corresponding Author must be

entered in the Author object (see chapter Entering Authors to

learn how to enter in the FAX number)

3. Telephone - the telephone number of the Corresponding Author

must be entered in the Author object (see chapter Entering

Authors to learn how to enter in the telephone number)

The selected notification appears in the notification field

(Figure 5.8).
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Figure 5.8

• Format - The paper format for this manuscript is selected from

this popup menu (Figure 5.9).

Select the Format of 
the manuscript from 

this popup menu

Figure 5.9

The selected format appears in the format field (Figure 5.10).

Figure 5.10

The format that you select for a manuscript is discussed in the Author’s

Guidelines that are published with the journal.
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Adding Authors

There are three methods to add Authors to a manuscript window.

1. Drag the Red Link Control Button on any opened author window

to the new manuscript window.  Use this if the author window

already opened

2. Drag the Authors from the List of All Authors Window to the new

manuscript window.  Use this to drag in several Authors in one

action.

3. Drag the Authors from another opened manuscript window to the

new manuscript window

Using the Red Link Control Button

1. Press and hold the mouse button on the red link control button

2. Without releasing the mouse, drag the red triangle to the manuscript

window and drop it in the Authors List Field (Figure 5.11)
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Drag the Red Triangle 
from the Author Window 

to the Manuscript 
Window to add an author

Figure 5.11

The cursor is initially an ARROW when pressing on the red triangle.

When it moves into the Authors List Field, it changes to a GRAB hand.  A

small square is dragged from window to window.  When the mouse button

is released in the Authors List Field (dropped), the Author John Doe is

added as an Author to the manuscript object (Figure 5.12).
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Author Added

Figure 5.12

Adding from the List of All Authors Window

1. Select one or more of the Authors from the list

2. To select more than one Author, hold down the SHIFT key while

pressing the mouse button on each Author

3. The last Author selected becomes the drag anchor

4. The mouse button must be released after the last selection

5. Press and hold the mouse button down again on the last Author

selected, or on the single selection
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6. Without releasing the mouse, drag with the mouse the entire selection

to the manuscript window and drop it in the Authors List Field

(Figure 5.13)

Drag selected authors from 
the List of All Authors 

Window to the Manuscript 
Window to add authors

Figure 5.13

The cursor is initially an ARROW when pressing on the selected Author(s).

When it moves into the Authors List Field, it changes to a GRAB hand.

An outline of the selection is dragged from window to window.  When the

mouse button is released in the Authors List Field (dropped), the selected

Author(s), in this case John Doe, is added as Author(s) to the manuscript

object (Figure 5.14).
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Author Added

Figure 5.14

Adding from Another Manuscript Window

1. Select one or more of the Authors from the list of Authors on a

manuscript window

2. To select more than one Author, hold down the SHIFT key while

pressing the mouse button on each Author

3. The last Author selected becomes the drag anchor

4. The mouse button must be released after the last selection

5. Press and hold the mouse button down again on the last Author

selected, or on the single selection

6. Without releasing the mouse, drag with the mouse the entire selection

to the new manuscript window and drop it in the Authors List Field
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(Figure 5.15)

Drag selected authors from 
the any Manuscript Window 

to the new Manuscript 
Window to add authors

Figure 5.15

The cursor is initially an ARROW when pressing on the red triangle.

When it moves into the Authors List Field, it changes to a GRAB hand.  A

small square is dragged from window to window.  When the mouse button

is released in the Authors List Field (dropped), the selected Author(s), in

this case John Doe, is added as Author(s) to the manuscript object

(Figure 5.16).
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Author Added

Figure 5.16
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Deleting an Author

Authors may be deleted from the manuscript window.  If the Corresponding

Author is deleted, the Corresponding Author field is cleared (Figure 5.17).

1. Select the Authors from the Authors list

2. To select more than one Author, hold down the SHIFT key while

pressing the mouse button on each Author

3. Hit the Delete key.  All selected Authors are deleted

Hit Delete key to 
remove an author 

from this manuscript

Figure 5.17
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Author Order

The order of the Authors is based on the order in which they are added to

the list.  The first author  is at the top of the list, and the last author is at

the bottom.

To change the order:

1. Position the mouse in the list.

2. Select the Author that is to be moved

3. The mouse button must be released once

4. Press and hold the mouse button down again on the selected Author.

5. Drag the Author with the mouse up or down to change the order.

6. When you release the mouse button, the list redraws to reflect the

new order (Figure 5.18)
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Drag selected author up and down to change the author order

Figure 5.18

One special condition is when changing the second Author into the first

Author.  In this case, move the first Author down,. Do not move the

second Author up.
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Corresponding Author

The Corresponding Author  is selected from one of the Authors..  This is

required before the manuscript can be submitted.  This Author receives all

notification messages from the SMART server regarding the submitted

manuscript.

To attach the Corresponding Author:

1. Select the correct Author from the list

2. The mouse button must be released once

3. Press and hold the mouse button down again on the selected Author

4. Drag the Author with the mouse to the field labelled Corresponding

Author (Figure 5.19)

Drag any selected author 
to the Corresponding 

Author field 

Figure 5.19
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The cursor is initially an ARROW when pressing on the selected Author.

When it moves into the Corresponding Author Field, it changes to a

GRAB hand.  A outline of the selection is dragged from field to field.

When the mouse button is released in the Corresponding Author Field, the

name of the selected Author is displayed (Figure 5.20).

Corresponding Author

Figure 5.20
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Determining Completeness

The manuscript is not ready for submission.  More information need to be

completed. Select Check Manuscript Completeness from the Manuscripts

Menu (Figure 5.21) to determine what still needs to be completed.  The

keyboard equivalent of Command-K can also be entered from the keyboard

Figure 5.21

A dialog indicates what items require attention, or if the manuscript is

ready to be submitted.  Figure 5.22 shows that manuscript files still need

to be attached to the manuscript object.

Figure 5.22
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Finishing Up the Manuscript

The display buttons in the manuscript window  display more information.

Some information is required and some are optional.  Those that are listed

as optional are included because SMART will become a full authoring

tool in the future, at which time the attachment of files will not be necessary.

However, until that transition is made, these text fields are available, and

Authors may elect to add this information into the optional fields

• Manuscript - displays the current window containing the most

immediate information about this manuscript, such as the title,

the Authors, the Corresponding Author, the journal, and the format.

All of this information is required.

• Abstract - displays the abstract which may have been be entered.

This is optional.  The abstract is generally in one of the files

attached to this manuscript.

• Body - displays the body of the manuscript which may have been

entered.  This is optional.  The body is generally in one of the

files attached to this manuscript.

• Legends - displays the legends of figures in the manuscript which

may have been entered.  This is optional.  The legends are generally

in one of the files attached to this manuscript.

• References - displays the references in the manuscript which

may have been entered.  This is optional.  The references are

generally in one of the files attached to this manuscript.

• Keywords - displays the keywords in the manuscript.  This is
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required.  The keywords used in SMART are standardized for the

supported journals.

• Files - this button displays the field in which the files for the

manuscript are to be attached to this manuscript object.  This is

required.

• Suggested Reviewers  - displays the suggested Reviewers for the

manuscript which may have been entered.  This is optional.  The

Reviewers are added as text, not as Author objects.

• Cover Letter - displays the cover letter for the manuscript which

may have been entered.  This is required.

• Comments - displays the comments for the manuscript which

may have been entered.  This is optional.

Alert: Only the Manuscript, Keywords, Files, and Cover Letter

information need to be completed in order to submit a manuscript object to

SMART.

Manuscript - this has been described in full detail in the previous

sections.
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Abstract - The window is displayed in Figure 5.23.

Enter the Abstract here

Figure 5.23

Currently, this information is not required.  This may change in the future

when SMART becomes more of an authoring tool.  Presently, this

information is optional.
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Body - The window is displayed in Figure 5.24.

Enter the Body here

Figure 5.24

Currently, this information is not required.  This may change in the future

when SMART becomes more of an authoring tool.  Presently, this

information is optional.
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Legends - The window is displayed in Figure 5.25.

Enter the Legends here

Figure 5.25

Currently, this information is not required.  This may change in the future

when SMART becomes more of an authoring tool.  Presently, this

information is optional.
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References - The window is displayed in Figure 5.26.

Enter the References here

Figure 5.26

Currently, this information is not required.  This may change in the future

when SMART becomes more of an authoring tool.  Presently, this

information is optional.
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Keywords - The window is displayed in Figure 5.27.

Enter in search string

Search mode

Initiate search

Search results

Keywords stored for this 
manuscript

Figure 5.27

Keywords are required before the manuscript object can be submitted.  All

keywords are chosen from an internal standardized list in SMART.

Searching for Keywords:

1. Type in a string in the field labelled Enter in string to find

2. The search method can be modified by selecting either Begins With

or Contains

3. Pressing on the Find button or pressing the RETURN or the ENTER

key  intiates a search

All matches are displayed in the scrolling field labelled Keyword Matches.

Adding Keywords:
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1. Select the desired keywords from the Keyword Matches list

2. To select more than one keyword, hold down the SHIFT key while

pressing the mouse button on each keyword

3. The last keyword that selected becomes the drag anchor

4. The mouse button must be released after the last selection

5. Press and hold the mouse button down again on the last keyword

selected, or on the single selection

6. Without releasing the mouse, drag with the mouse the entire selection

to the Keywords field

When the mouse button is released, the selected keywords are added to the

Keywords list (Figure 5.28).

Drag selected keywords to add to list

Figure 5.28
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Deleting keywords:

1. Select the keywords from the Keywords list

2. To select more than one keyword, hold down the SHIFT key while

pressing the mouse button on each keyword

3. Hit the Delete key.  All selected keyword(s) are deleted
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Files - The window is displayed in Figure 5.29.

Attached files 
added listed here

Press here to 
add files

Drag files into 
this field

Figure 5.29

Files containing the content of the manuscript must be authored with another

word processing program and added or attached to this manuscript.  Files

are added by dragging them from the desktop to the field or by pressing

on the Add... button.

Dragging from the Desktop

1. Select all the files from the Finder

2. Press and hold the mouse button down on one of the selected files

3. Without releasing the mouse, drag with the mouse the entire selection

to the field labelled Files (Figure 5.30)
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Drag Files from 
Desktop to Window

Figure 5.30

Tip: You can drag folders or disks into this files field in the manuscript

window, but only files are added to the list.  Folders and drives are ignored.

When you release the mouse button, all of the selected files are added to

the manuscript object (Figure 5.31).
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.

This file was 
dragged in from 

the Desktop

Figure 5.31

Using the Add button

1. Press on the Add... button

2. A file dialog opens requesting the manuscript file to attach

(Figure 5.32)

3. Select the file

4. Press the Open button.  The single file is added to the list of files in

this manuscript

Figure 5.32
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The location of all files are stored in the manuscript object.  Therefore, the

original files must remained in their current location until the manuscript

is submitted.  The process of submitting the manuscipt to the database

copies each file to the database.

Format - As files are being added, their file creator and type are checked

against some known word processing and graphics programs.  The Format

column may automatically reflect the proper information.  This information

may also be manually selected.

1.  Select one or more of the files

2. Press and hold on the button labelled Word Processor to display a

popup menu (Figure 5.33)

3. Select the application that matches the selected files.  The selection

is added to each file selected and displays in the Format column.

Some popular 
software 

applications

Format of the files 
attached to this 

manuscript
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Figure 5.33

Comments - Select one or more of the files.  Press on the button labelled

Comments.  A dialog opens for any comment (Figure 5.34).

Figure 5.34

The comment is added to each file selected and displays in the Comments

column (Figure 5.35).

Comments of the 
files attached to this 

manuscript

Figure 5.35

Deleting Files
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1. Select the files from the Files list

2. To select more than one file, hold down the SHIFT key while

pressing the mouse button on each file

3. Hit the Delete key.  All selected files are deleted

Alert: This does not delete the actual file from your disk.  It only removes

the link of the file from this manuscript
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Suggested Reviewers - The window is displayed in Figure 5.36.

Enter the Reviewers here

Figure 5.36

Suggested Reviewers for this manuscript are entered here.
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Cover Letter - The window is displayed in Figure 5.37.

Enter the Cover Letter here

Figure 5.37

A cover letter is required before the manuscript object can be submitted.

This field is sensitive to drag and drop, so you can author the cover letter

in another word processor, select the text, and drag and drop it into this

field.
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Comments - The window is displayed in Figure 5.38.

Enter the Comments here

Figure 5.38

Enter in any comments on the manuscript here in this field.  This information

is optional.
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Opening a Manuscript

Manuscripts saved to the document may be reopened for browsing or for

additional editing if not yet submitted.

Press on the Open button after selecting a manuscript in the document

window.  You can also select Open Manuscript in the Manuscripts

Menu.  This menu item is enabled only when a manuscript is selected.  Or

you can double-click on the selected manuscript in the document window.

A manuscript window with this manucript object opens.  Browse or edit

the manuscript object if this manuscript has not yet been submitted.  If the

manuscript has already been submitted, the data can only be browsed.
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Deleting a Manuscripts

Manuscripts saved to the document may be deleted.  Deletion of the

manuscript does not remove it from the database nor remove its eligibility

from review.  This only removes the link from the document.

Press on the Delete button after selecting a manuscript in the document

window.  You can also select Delete Manuscript in the Manuscripts

Menu.  This menu item is enabled only when a manuscript is selected.

You can also press the Delete key on the keyboard  A confirmation dialog

appears twice Figure 5.39.

Figure 5.39

This action can be undone by selecting Undo Delete Manuscript in the

Edit Menu (Figure 5.40).  The manuscript is listed again in the document

window.
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Figure 5.40

The undo of the deletion itself can also be undone, known as an redo.

Select Redo Delete Manuscript in the Edit Menu (Figure 5.41).  The

manuscript is again deleted from the document.

Figure 5.41
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Printing a Manuscripts

A manuscript can be printed at any time, whether it has been been submitted

or not.  Any time that a manuscript has been saved to the document,

whether it has been submitted or not, it can be printed.

Press on the Print button after selecting a manuscript in the document

window.  You can also select Print Manuscript in the Manuscripts

Menu.  This menu item is enabled only when a manuscript is selected.  If

a printer is selected, a summary of the manuscript object is printed.  This

function does not print the contents of the attached files.  It only prints the

information that is entered with SMART.  Figure 5.42 shows an example

of a print report.

ID: 2
Created: Thu 07/25/1996 11:01:07 AM (GMT)

Title: The cytoarchitectonics of the Nucleus Ambiguus in the rat
Authors: Doe,John,E.
Corresponding Author: 
Journal: BRAIN RESEARCH INTERACTIVE
Theme: Spinal cord and brainstem: anatomy
Notification: EMail
Paper Format: Research Articles
Keywords: Cytoarchitecture, Brainstem, Circuit
Abstract: None
Body: None
Figure legends: None
References: None

Figure 5.42
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Submitting the Manuscript

The manuscript object is ready to submit to the SMART server when the

Submit button is enabled.  Submit Manuscript from the Manuscripts

Menu may also be selected (Figure 5.43).  This menu item is enabled only

when the manuscript is ready to be submitted.

Figure 5.43

A confirmation dialog opens requesting to save all of the data to the disk

(Figure 5.44).

Figure 5.44

Pressing the OK button saves the data and continues the submission

process.  A final confirmation window appears summarizing the manuscript

object.  Confirm that this is the correct manuscript object and the journal

selected for the publication is correct (Figure 5.45).
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Verify the title, authors, 
and journal.  Once the 

Submit process begins, 
you cannot interrupt it

Figure 5.45

Pressing the Submit button starts the submission process.  If the network

configuration is incorrect, or if there is any problem in using the network

or accessing the server, an error message appears.

Figure 5.45

The submission process cannot be interrupted once it begins.  The progress

bar and progress message is in use on the document window for this

manuscript.  Depending on the type of connection you have to the Internet,

the size of the files, and the activity at the SMART server, submission can

take anywhere from seconds to minutes.  The progress field shows the

amount of data remaining to be sent, especially the size of the files.
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Tip: If the document window is behind the manuscript window, you won't

be able to see the messages.  Move the document window to expose the

progress bar and message field.

If there is any error by the server, or a network interruption after the

transmission has started, an error message appears (Figure 5.46).

Figure 5.46

If this happens, try again later.  If it continues, please contact Technical

Support.

When the manuscript object has been successfully sent to the server, the

following message appears, with a unique ID assigned to your manuscript

(Figure 5.47).

Figure 5.47
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In this example the manuscript has been assigned an ID of 1001.  This can

be used to identity your manuscript to this journal in all communications,

either electronic, voice, or mail.

After submitting, the manuscript window closes.  The document window

updates to reflect that this manuscript has been submitted (Figure 5.48).

Unique ID

Submission Date/Time

Figure 5.48

The manuscript shows the ID in the ID column, and the Status column

shows the submitted date and time .  The Submit button in the manuscript

window for this manuscript is disabled if reopened.  The manuscript cannot

be resubmitted.  Furthermore, certain fields are read-only and popup menus

are disabled, protecting the current selections (Figure 5.49).
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When a manuscript has 
been submitted, 

certain items are disabled

Figure 5.49

New Authors cannot be added to the Authors field.  However, the Authors

in a submitted manuscript may be selected and dragged to a new manuscript

window.
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Checking a Manuscript

Once a manuscript has been successfully submitted to SMART, the status

of the manuscript can be checked by using the Check button on the document

window.

Pressing on the Check button after selecting a manuscript in the document

window starts the checking process.  Check Manuscript in the Manuscripts

Menu can also be selected.  This menu item is enabled only when a

manuscript is selected.  If the network configuration is incorrect, or if

there is any problem in using the network or accessing the server, an error

message appears.

Figure 5.49

The checking process cannot be interrupted once it begins.  The progress

bar and progress message is in use on the document window for this

manuscript.  If there is any error by the server, or a network interruption

after the checking has started, an error message appears (Figure 5.50).

Figure 5.50
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If this happens, try again later.  If it continues, please contact Technical

Support.

Alert: The checking process is not automatically done when you open the

document window.  You must initiate the check by using the Check button.

When the manuscript has been successfully checked by the server, a message

window appears with the status.  There is one general message if the

manuscript is anywhere in the review process (Figure 5.51).  The extent of

the message, if any, is determined by the editors.

Figure 5.51

Manuscript is under review means that the manuscript has been submitted,

and is in the review process.  The specific phase of the review process is

not reported.

Other messages appear once the review process has comcluded for

Acceptance, Rejection, and Revision.
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Chapter 6
Revising a Manuscript

This chapter will show you how to retrieve a manuscript object for a

revision should the editors request one from the corresponding author.

• Editorial request for revision

• Retrieving and Revising the Manuscript
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Editorial Request for Revision

If a revision is necessary, the editors will contact the corresponding author

through his  preferred mode of notification.  The following letter is a

sample of the communications (Figure 6.1).

Your manuscript previous submitted needs a revision as requested by 
the editors. Please save your author ID, the manuscript ID, and the 
manuscript password.  You will need these in order to download the 
manuscript.

Manuscript ID:        1001
Submission Date:      12/27/96 11:46:02 PM (GMT)
Title:                The cytoarchitechtonics of the Nucleus Ambiguus 
                      in the rat
Journal:              Brain Research Interactive
Theme:                Spinal Cord and Brainstem: anatomy
Keywords:             Cytoarchitecture, Brainstem, Circuit
First author:         Doe, John
Corresponding author: Doe, John
CoAuthors:            Edwards, Thomas, A., White, Robert, G.

Author ID             1007
Manuscript password:  ArterialBlood

Figure 6.1

The manuscript ID, password, and your ID are used to retrieve the manuscript.

If you lose this information, you have to contact the journal Editor to get a

new password.
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Retrieving the Manuscript

Select Retrieve Manuscript for Revision in the Manuscripts Menu to

retrieve your original manuscript object.  A window opens and requests

certain information in order to retrieve the manuscript  (Figure 6.2).

Figure 6.2

The User ID is your assigned ID.  The Manuscript ID is unique to the

manuscript.  The Password is case sensitive and unique to you and the

manuscript (Figure 6.3).

Figure 6.3

Pressing on the Accept button opens a file dialog requesting a location to

store the downlaoded files (Figure 6.4).  These are the original files that

you attached to the manuscript object.  The dafault name for the folder is

Download with the current date appended.
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Figure 6.4

Pressing on the Save button  begins the retrieval process.  If the network

configuration is incorrect, or if there is any problem in using the network

or accessing the server, an error message appears (Figure 6.5).

Figure 6.5

The retrieval process cannot be interrupted once it begins.  The progress

bar and progress message is in use on the document window for this

manuscript.  Depending on the type of connection you have to the Internet,

the size of the files, and the activity at the SMART server, retrieval can

take anywhere from seconds to minutes.  The progress field shows the

amount of data remaining to be received, especially the size of the files.
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Tip: If the document window is behind the manuscript window, you won't

be able to see the messages.  Move the document window to expose the

progress bar and message field.

If there is any error by the server, or a network interruption after the

transmission has started, an error message appears (Figure 6.6).

Figure 6.6

If this happens, try again later.  If it continues, please contact Technical

Support.

When the manuscript object has been successfully retrieved from the server,

the document window updates to reflect that this manuscript has been

retrieved (Figure 6.7).
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Revision

Figure 6.7

The manuscript shows the ID in the ID column, with the letter ‘R’ appended,

followed by the number of revisions for this manuscript.  The status column

shows Revision in progress.  A manuscript window opens for this manuscript

Figure 6.7

In a revision, you are restricted from altering the authors or the corresponding

author.  You cannot add new suggested reviewers.  Most everything else

can be changed.  Primarily, you will review the files sent with the manuscript,
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make changes as needed, attached new files as described in the previous

chapter, and resubmit the manuscript.  To resubmit the revised manuscript,

use the same Submit button at the button and follow the same instructions

as provided in the previous chapter.



1 Appendix A

Appendix A - Certified Software Applications

SMART is not an authoring program.  This means that the Author creates

the content of the manuscript with other programs, and use SMART to

bind them together into a manuscript object that is then transmitted over

the Internet to the SMART system.  Since the Reviewers and Editors of

SMART require that they be able to open and view your files, certified

software applications are below.  The Author should make every effort to

use one of more of these applications when authoring the manuscript.  If

this is not possible, the Author should comment heavily on the name and

version of the program, the computer, and the version of the operating

system in the Comments field of each file, or put this information in the

Comments section of the manuscript object.

Word Processors: (Macintosh)

• Microsoft Word 3.0, 4.0, 5.0, 6.0

• WordPerfect 3.0

• PageMaker 5.0

• NisusWriter 4.0

Spreadsheets: (Macintosh)

• Excel 5.0

•

Graphics: (Macintosh)

• MacDraw II

• Canvas

• Photoshop
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• Illustrator

• Freehand
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Appendix B - Optimizing Memory

The documents are RAM based.  Virtual memory, either Apple’s virtual

memory or  Connectix’s RAM Doubler, can be used with this application.

However, neither is recommended.  Apple’s virtual memory mechanism is

very inefficient.  RAM Doubler works better but it too can cause noticeable

delays when physical free RAM is low.  Be sure that 32 bit addressing is

on for the older Macintoshes, and that the Modern Memory Manager for

PowerPCs is on.

To turn off virtual memory  (Figure B1):

1. Choose Control Panels from the Apple menu, then double-click

Memory.

2. Press on the Off button to turn off virtual memory.

3. Choose Restart from the Special menu.

Figure B1
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You should read the Appendix on Optimizing Memory to set the memory

parameters for this application to the proper levels.
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Appendix C - Networking Issues

This application uses the Internet and the TCP/IP protocol to communicate

with the SMART server.  The Macintosh computer must be capable of

accessing the Internet, and must be able to run TCP/IP.  On the Macintosh,

TCP/IP is provided by using either MacTCP or Open Transport.

• The minimum version of MacTCP is 2.0.6

• The minimum version of Open Transport is 1.1

Apple’s AppleTalk Remote Access (ARA) can also be used with either of

the two IP enabling programs above to provide network access, but the

transmission speeds are limited to the speed of the phone modem used to

make the ARA connection.

IP Address and Port number must be configured.  See the chapter on

The Basics to see how to do this.  The addresses and port number are:

Current IP Address of SMART Server (as of Jan 1, 1997):

• 192.26.252.151

Current Port Number of SMART Server (as of Jan 1, 1997):

• 7000
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Appendix D - Useful Commercial Software

Connectix’s Speed Doubler should be used on every PowerMacintosh

because it replaces Apple’s Motorol 680x0 emulator with a much better

one.  This application was written in QKS SmalltalkAgents, and only

portions of it are in native PowerPC code.  With Speed Doubler, throughput

probably increases (as well as in many other commercial software

applications) by at least two-fold.
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Appendix E - Themes

The abbreviated list of themes is from the Society for NeuroSciences

themes.

THEME A: DEVELOPMENT AND REGENERATION
Developmental genetics
Genesis of neurons and glia
Cell lineage and determination
Cell differentiation and migration
Pattern formation, compartments, and boundaries
Process outgrowth, growth cones, and sprouting
Axon guidance mechanisms and pathways
Formation and specificity of synapses
Neurotransmitter systems and channels
Neurotrophic factors: expression and regulation
Neurotrophic factors: biological effects
Neurotrophic factors: receptors and cellular mechanisms
Hormones and development
Nutritional and prenatal factors
Neuronal death
Glia and other non-neuronal cells
Motor systems
Sensory systems
Cerebral cortex and limbic system
Visual system
Regeneration
Transplantation
Aging process

THEME B: CELLULAR AND MOLECULAR BIOLOGY
Staining, tracing, and imaging techniques
Neuroglia and myelin
Membrane composition and cell-surface macromolecules
Cytoskeleton transport and membrane targeting
Blood-brain barrier
Gene structure and function: general

THEME C: EXCITABLE MEMBRANES AND SYNAPTIC TRANSMISSION
Presynaptic mechanisms
Mechanisms of neurotransmitter release
Postsynaptic mechanisms
Long-term potentiation: physiology
Long-term potentiation: pharmacology
Ligand-gated ion channels
Sodium channels
Calcium channel structure, function, and expression
Calcium channel physiology, pharmacology, and modulation
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Potassium channel structure, function, and expression
Potassium channel physiology, pharmacology, and modulation
Other ion channels

THEME D: NEUROTRANSMITTERS, MODULATORS, TRANSPORTERS,
AND RECEPTORS

Acetylcholine
Acetylcholine receptors: muscarinic
Acetylcholine receptors: nicotinic
Excitatory amino acids: excitotoxicity
Excitatory amino acids: anatomy and physiology
Excitatory amino acids: pharmacology
Excitatory amino acid receptors: structure, function and expression
Excitatory amino acid receptors: physiology, pharmacology and modulation
GABA receptors
GABA
Peptide receptor structure and function
Peptides: biosynthesis, metabolism, and biochemical characterization
Peptides: anatomy and physiology
Opioid receptors
Opioids: anatomy, physiology, and behaviour
Catecholamine receptors
Catecholamines
Serotonin receptors
Serotonin
Other neurotransmitters
Transmitters in invertebrates
Interactions between neurotransmitters
Uptake and transporters
Regional localization of receptors and transmitters
Second messengers and phosphorylation
Signal transduction: gene expression
Behavioural pharmacology
Receptor modulation, up- and down-regulation

THEME E: ENDOCRINE AND AUTONOMIC REGULATION
Hypothalamic-pituitary-adrenal regulation
Hypothalamic-pituitary-gonadal regulation
Osmotic and thermal regulation
Neuroendocrine regulation: other
Neural-immune interactions
Cardiovascular regulation
Gastrointestinal and urogenital regulation
Respiratory regulation

THEME F: SENSORY SYSTEMS
Somatic and visceral afferents
Spinal cord
Subcortical somatosensory pathways
Somatosensory cortex and thalamocortical relationships
Pain: pathways
Pain modulation: anatomy and physiology
Pain modulation: pharmacology
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Retina and photoreceptors
Subcortical visual pathways
Visual cortex: striate
Visual cortex: extrastriate
Visual psychophysics and behaviour
Auditory, vestibular, and lateral line: periphery
Auditory systems: central physiology
Auditory systems: central anatomy
Olfactory senses
Gustatory senses
Invertebrate sensory systems

THEME G: MOTOR SYSTEMS AND SENSORIMOTOR INTEGRATION
Cortex
Basal ganglia
Thalamus
Cerebellum
Vestibular system
Oculomotor systems
Reflex function
Spinal cord and brainstem
Control of posture and movement
Circuitry and pattern generation
Invertebrate motor function
Muscle

THEME H: OTHER SYSTEMS OF THE CNS
Limbic system and hypothalamus
Association cortex and thalamocortical relations
Comparative neuroanatomy
Brain metabolism and blood flow

THEME I: NEURAL BASIS OF BEHAVIOUR
Cognition
Learning and memory;: systems and functions
Learning and memory: physiology
Learning and memory: pharmacology
Neural plasticity
Motivation and emotion
Biological rhythms and sleep
Neuroethology
Invertebrate learning and behaviour
Ingestive behaviours
Stress
Hormonal control of reproductive behaviour
Monoamines and behaviour
Neuropeptides and behaviour
Drugs of abuse: alcohol, barbiturates, and benzodiazepines
Drugs of abuse: amphetamine and other stimulants
Drugs of abuse: cocaine
Drugs of abuse: opioids and others
Psychopharmacological agents
Aging
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THEME J: DISORDERS OF THE NERVOUS SYSTEM
Genetic models
Developmental disorders
Epilepsy: human studies and animal models
Epilepsy: basic mechanisms
Epilepsy: anti-convulsant drugs
Degenerative disease: Alzheimer's - beta amyloid
Degenerative disease: Alzheimer's - cognitive function
Degenerative disease: Alzheimer's - neuropharmacology and
neurotransmitters
Degenerative disease: Alzheimer's - miscellaneous
Degenerative disease: Parkinson's
Degenerative disease: other
Ischemia
Trauma
Infectious diseases
Neuromuscular diseases
Neuropsychiatric disorders
Neurotoxicity
Neuro-oncology


